


































































































































































































































































































































































































each of these programs, you will have a comprehensive understanding of the techniques 
used in GEM programming. 

A Sample GEM Application 

The GEM application example is called DEMO.APP. Several different files sup­
port your programming education with this sample application: 

DEMO.APP-actual GEM application. 
DEMO.BAT-batch file for RASM. 
DEMOM.BAT -batch file for MASM. 
DEMO.C-Lattice C source code. 
DEMO.DEF -definitions for DEMO.H. 
DEMO.H-inc1ude file. 
DEMO.lNP-LINK-86 link input. 
DEMO.RSC-resource file. 

The two batch files are used for supporting different compilers. 
Several different standard GEM Desktop operations are also demonstrated by 

DEMO.APP: 

Drop-down menus 
Error dialogs 
Warning dialogs 
Opening windows 
Scrolling windows 
Closing windows 

The basic procedure for programming a GEM application, similar to DEMO.APP, 
follows these highly generalized steps: 

1. Use the GEM Resource Construction Set for creating the Menu Bar and the dialogs. 
2. Design the application's icons with the GEM ICONEDIT (Fig. 7-1). 
3. Write the application source code in Lattice C and a word processing program (such 

as WordStar in Non-document mode). 
4. Compile the source code. 
5. Debug the compiled code with GEM-SID. 
6. Market your completed application. 

A Sample GEM Desk Accessory 

The GEM Programmer's Toolkit-supplied desk accessory example is called 
HELLO.APP. Once again, several different files complement your programming edu­
cation with this sample application: 

HELLO.APP-actual GEM desk accessory. 
HELLO. BAT-batch file for RASM. 
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DIsk Fil! Op!ration 

Fig. 7-1. ICON EDIT is used for designing GEM icons. 

HELLOACC.BAT-batch file for RASM HELLO accessory. 
HELLOM.BAT-batch file for MASM. 
HELLOMAC.BAT-batch file for MASM HELLO accessory. 
HELLO.C-Lattice C source code. 
HELLO.INP-LINK-86 link input. 
HELLOACC.lNP-RASM link input as accessory. 

The four batch files are used for supporting different compilers and for making HELLO 
an application, as well as a.desk accessory. 

The basic procedure for programming a GEM desk accessory, similar to 
HELLO.APP, follows these highly generalized steps: 

1. Use the GEM Resource Construction Set for creating the Menu Bar and the dialogs. 
2. Write the application source code in Lattice C and a word processing program (such 

as WordStar in Non-document mode). 
3. Copy DESKAPPO.H to DESKACCO.H. 
4. Compile the source code. 
5. Debug the compiled code with GEM-SID. 
6. Copy DESKAPP1.H to DESKACC.H. 
7. Recompile. 
8. Sell your completed desk accessory to the highest bidder. 

The extra copy and recompile steps are necessary because a desk accessory is non-
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executable during the debugging stages. Therefore, the accessory must be first con­
verted into an application, debugged, and then converted back into an accessory. The 
batch files for the RELLO.APP accessory cover several methods for performing this 
conversion. 

Porting GEM 

The term porting is greatly misused in non-programming circles. The average com­
puter user assumes that a portable program is one that can be made to run on vastly 
different computer systems. To a programmer, however, porting refers to the modifi­
cation of a program so that it will run on any other computer. The computer being 
ported to can have either the same MPU as the original system or an entirely foreign 
MPU. Therefore, in a programmer's eyes, a GEM application would have to be ported 
to run on an IBM PCjr, for example. Conversely, the non-programmer would only con­
sider taking GEM into the 68000 MPU environment as porting. Aside from all of this 
hairsplitting, suffice it to say that GEM applications are highly portable. 

The included files (.R type) in The GEM Programmer's Toolkit are the site of the 
major porting chores. By altering these files with the new machine-specific function 
and system calls, a GEM application can be easily (this is a relative term) ported over 
to the new environment. Application areas that would require additional conversion 
would be those containing resolution-dependent features. Such features would include 
icons. By far, the best way of making a GEM application portable is to use a program­
ming module approach that clearly labels each machine-specific portion. Then, when 
you decide to port the application to another environment, the new machine-specific 
code can be quickly (again, relatively speaking) substituted for the marked modules. 

GEM VOl 

The obvious strong suit of GEM is its graphics-oriented approach to solving operating 
system limitations. This graphics system also provides convenient "hooks" for organiz­
ing dissimilar applications into a common environment. One of the potential flaws in 
organizing a true graphics environment is incompatibility among the hundreds of pos­
sible graphics devices used with today's microcomputers. This diversity in hardware 
could actually destroy the ability of GEM to deal effectively within a graphics environ­
ment. In order to combat any possible degradation in GEM, DRI developed the VDI, 
or virtual device interface. The VDI gives GEM a portable hardware interface for deal­
ing with graphics 110 (input/output). 

Basically, the GEM VDI is a programming interface that offers operating system 
compatibility. Additionally, like on the open range, the GEM VDI rides herd over any 
connected I/O device. This leaves the programmer free to concentrate on the applica­
tion creation without worrying about device drivers. Two major components make up 
the GEM VDI: the Graphics Device Operating System (GDOS) and the specific device 
driver and face file (or system fonts). The amount of system memory consumed by 
the GEM VDI is less a function of the GDOS than it is the device driver. On the aver­
age, the GDOS takes 5K-7K bytes, while the device driver takes 30K-40K bytes. In 
order to appreciate both the significance and the diverse memory use of the device 
driver, you must realize its function. 
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The device driver portion of the GEM VDI houses all of the device drivers used 
by the installed GEM Desktop. This includes the graphics card, mouse, printer, and 
font drivers. By using this method, DRI has removed a prime concern of the applica­
tion programmer-peripheral support. Following a typical GEM application scenario, 
the program addresses each device in a standard method with the GEM VDI device 
driver performing all of the translation. 

The other portion of the GEM VDI, the GDOS, controls the coordinate scaling sys­
tem used on the particular computer system. This means that the GDOS is a machine­
specific module within the GEM VDI. Two different types of coordinate scaling methods 
are used by the GDOS: Normalized Device Coordinate and Raster Coordinate systems. 
The Normalized Device Coordinate method transforms the display coordinates into de­
vice coordinates through a normalized space. Conversely, the Raster Coordinate sys­
tem deals in real device coordinates without any transformation. Of these two coordinate 
methods, the Raster Coordinate system is stressed by The GEM Programmer's Toolkit. 
Supporting this recommendation are several raster operations that enhance the pro­
gramming of a GEM application or desk accessory. 

The Open Workstation function is used for setting the coordinate method: 

v _opnwk( worLin, &handle, worLout ) 

This is the Lattice C binding supplied with The GEM Programmer's Toolkit. 
The device drivers serve as translators between the graphics primitives of the GEM 

VDI and the connected graphics output device. Each device is given a specific driver, 
which is installed during GEMPREP (or added later with GEMSETUP). Based on this 
bit of information, your next question should be, "How is GEM able to manage the 
several device drivers that it uses?" In the GEM VDI, each memory-resident device 
driver is assigned a number. The currently running GEM application is then able to 
selectively output data to the specified device through the proper identification number. 

This same installation and memory management system applies to the GEM VDI 
face files as well. In other words, the required system fonts are installed with GEM­
PREP (or added later with GEMSETUP). These system fonts are for both the screen 
and the selected output device. A special text file called ASSIGN.SYS holds a listing 
of the device drivers, the face files, and their associated device numbers. The device 
numbers are set by the selected output device. For example, the printer output device 
uses 21-30 as device numbers. 

Displaying these system fonts can be performed in either the Point mode or the 
Absolute mode. In the Point mode, text created with the face files are fixed to either 
a IX or a 2X size. On the other hand, text displayed with a face file in the Absolute 
mode uses variable scaling from OX to 2X. There is a slight difference, however, in 
the way in which printer device drivers interpret these face file scaling modes. With 
the device printer drivers in The GEM Programmer's Toolkit, all face file text output 
to a printer is rounded down to the nearest scale. 

GEM AES 

Whereas the GEM VDI served as the universal graphics output interface, the GEM 
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AES (Application Environment Services) handles all of the user-generated, graphics­
based input through the GEM Desktop features. In other words, the GEM AES is able 
to read user input to icons, drop-down menus, dialogs, and menu-resident commands. 
Watching over these actions, there are five GEM AES parts that hold memory space: 
subroutine libraries, limited multitasking kernel, the Shell, desk accessory buffer, and 
menu/alert buffer. 

The subroutine libraries provide all of the subroutines or mini-applications that per­
form windowing, mouse movement, error handling, and screen/object manipulation. 
The subroutines will remain memory resident until the programmer intentionally re­
moves them. 

Without a doubt, the success of GEM is hinged on the limited multitasking kernel. 
This AES component is directly responsible for dividing the 8088's time for the appli­
cation, any background maintenance (including desk accessories), and the Screen Man­
ager. Remarkably, this time division must be carried off without the user becoming 
aware of the missing MPU time. Additionally, the other elements receiving the 8088's 
attention can't remove too much time from the application's execution. Therefore, the 
Dispatcher watches the consumption of the MPU's time. Two lists are made by the 
Dispatcher for 8088 time use-the Not-Ready List and the Ready List. 

The Not-Ready List holds all actions that are waiting for a particular series of events 
to occur. These events might be the press of a key, a wiggle of the mouse, or a tick 
on the clock. In contrast, the Ready List contains actions that are ready to run. Basi­
cally, an action is on the Ready List, if it is not waiting for one of the Not-Ready List 
events to happen. From these elementary descriptions, you can see that actions will 
move from one list to the other as one of the events occurs. Guiding the smooth trans­
fer or dispatching of each of these moving actions is how the Dispatcher earned its name. 

Only six desk accessories can be watched by the limited multitasking kernel. These 
six accessories are arranged into three different documents labeled DESK1.ACC, 
DESK2.ACC, and DESK3.ACC. These .ACC type documents are held in the desk ac­
cessory buffer of the GEM AES. For the programmer, there are three points to remem­
ber when dealing with accessories and the limited multitasking kernel. 

1. Use the overlay option (03H) of the DOS EXEC function call (4BH; Load or Exe­
cute a Program) for loading the accessory into memory. This desk accessory will then 
stay in memory until the programmer removes it. 

2. There must be at least 128K bytes RAM remaining after the desk accessory and 
the GEM application have both been loaded. 

3. The desk accessory must register (use the menlLJegister call) with the GEM AES 
before it will appear on the Desk Menu. 

In addition, you will need to know the accessory's: 

a. process indentifier. 
b. menu item indentifier. 
c. text string address. 

All mouse activities are monitored in the limited multitasking kernel by the Screen 
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Manager. The Screen Manager comes into play when the mouse leaves the area oc­
cupied by the active window. In particular, the Screen Manager is looking for mouse 
actions related to the following: 

Sizing and other window scaling 
Window movement 
Menu Bar and drop-down menu selection 
Limited shape change of the mouse to an arrow pointer 
Non-active window icon selection 

As its name implies, the Shell is an interactive layer between the subroutine libraries 
and the limited multitasking kernel. Granted, in the true context of the GEM AES, 
the Shell is a subroutine library, but it operates independently. These independent ac­
tions of the Shell are most visible when a GEM application is started from the GEM 
Desktop. Under these conditions the following happens: 

1. The Shell determines the nature of the application 

Is it graphics based? 
Is it character based? 
Is it a DOS application? 
Is it a GEM application? 

2. The GEM Desktop leaves the screen 
3. The Shell takes control 

no application is present-returns to the GEM Desktop 
graphics based-converts the screen to graphics mode and initiates GEM VDI 
Open Workstation call 
character based-converts the screen to character mode and initiates GEM VDI 
Close Workstation call 
DOS application-follows character-based execution 
GEM application-follows graphics-based execution 

Finally, the GEM AES is associated with screen refreshment. No, this isn't a GEM 
breath mint. Whenever a dialog or a menu fills the screen two events occur. First, the 
displayed dialog or menu is placed in the top layer of the GEM screen. Second, this 
dialog or menu covers a portion of the underlying GEM screen. Following these two 
events is the subsequent removal of the dialog or menu. Along with this erasure goes 
the piece of the screen that was underneath the dialog or menu. Therefore, a problem 
in screen refreshment becomes vital. 

The menu/alert buffer serves as a quick method for redrawing a portion of the screen 
that has been erased by a dialog or menu. Essentially, this buffer holds up to one fourth 
of the screen imagery prior to the arrival of the dialog or menu. After the dialog or 
menu is removed from the screen, the menu/alert buffer redraws the piece of the screen 
that had been covered. The speed of this redrawing is set by the buffer being memory 
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resident. Unfortunately, since this redraw buffer is located in the system memory, only 
a maximum of one fourth of the screen can be correctly restored. Therefore, limit the 
size of your dialogs and menus to less than one fourth the size of the screen. 

GEM RESOURCE CONSTRUCTION SET 

The finishing touch for a GEM application is the incorporation of icons, drop-down 
meilUs, and dialogs into the desktop. This last bit of graphics wizardry is accomplished 
with a tool found in The GEM Programmer's Toolkit-the Resource Construction Set 
(RCS). The RCS helps in the preparation of all of the key graphics features that are 
used by GEM. These graphics features are called resources in the parlance of the RCS. 
Adding a little bit of confusion to this issue is the naming convention that is used for 
the resource files that are created by the RCS. A file made by the RCS uses the .RSC 
type. In order to minimize this confusion, all .RSC files will be referred to as resource files. 

A resource file contains object trees. The "objects" in these object trees include 
text strings, exit buttons (e.g., "ok" buttons), and icons. Using the RCS is quite simi­
lar to any other GEM application (Fig. 7-2). 

D Choose the tree option. 
D Name the tree option. 
D Open the tree. 
D Collect the objects. 
D Name the objects. 

Desk File Global OPtions 

Fig. 7-2. The Resource Construction Set (RCS) develops the graphics for applications and desk ac­
cessories. 
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o Arrange the objects. 
o Close the tree. 
o Save the tree. 

Dealing with object trees can lead to some complicated, if not amusing, side ef­
fects. The Options Menu of the RCS holds several commands that operate on object 
trees. These commands manipulate parents, children, and, even, grandchildren. While 
this might add a bit of whimsy to the otherwise dreary activity of C programming, abus­
ing these commands can completely disrupt a resource file. The best advice here is 
to avoid the Options Menu, unless you are intimately familiar with the family opera­
tions of an object tree. Otherwise, you might see your resource file receive the Snap, 
Flatten, and Hide command treatment. 
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Chapter 8 

Twin Gems 
On September 30, 1985, the boom was lowered on Digital Research. It was on this 
date in history that Apple Computer struck a solid blow for visual copyright laws. But, 
given the proceedings in this case, this had to be the oddest legal battle ever fought 
in or out of a courtroom. 

In a nutshell, Apple's contention against GEM was that it mimicked the Macin­
tosh interface to such a faithful degree that GEM could be interpreted as a copyright 
infringement. Not being known for its fairness in this legal argument, the computer 
press belittled Apple's contentions by debasing its suit into a "look and feel" issue. 
Even magazine editorials (see BYTE Vol. 11 No.1) childishly lambasted Apple for 
pursuing such a destabilizing action. But no matter what your opinion is in this case, 
Apple was justifiable in calling GEM to task for its overly familiar Macintosh inter­
face. GEM does closely follow the visual interface of the Macintosh. Let me hasten 
to add that this statement isn't meant to suggest that the outcome of the eventual set­
tlement was either fair or just. It only serves as reinforcement of the grounds that Ap­
ple used for basing its contention. 

Actually, this is a court case that was never fought. The bottom line is that DRI 
settled out of court with Apple. Now, there are two sides to this type of settlement: 
the implied guilt side and the "cut your losses" side. With implied guilt, it is assumed 
that DRI was guilty of copyright infringement based solely on their pressing for an 
out-of-court settlement. This belief is pure hogwash. 

A more truthful accounting of DRI's action in this non-case is that they realized 
the legal ramifications of Apple's suit and decided to stave off a considerable waste 
in resources by settling out of court. It wasn't the money so much that concerned DRI, 
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it was the market life of GEM that was presented as the perishable resource. Basi­
cally, this resource absorption wouldn't have been limited to financial wealth; it would 
almost have certainly included a suspension in GEM sales during the legal proceed­
ings as well. The loss in revenue is a tangible fact, but the loss in sales is ephemeral 
and could spell the doom of GEM. In other words, a fickle market faced with Win­
dows, DESQview, and TopView isn't about to wait several months or even one year 
for the eventual release of a legally contested product. The end to all of this legal in­
trigue arrived on March 24, 1986, when DRI formally announced that a new version 
of the GEM Desktop (version 2.1; refer to Appendix A for a complete introduction to 
the new GEM Desktop) had been officially sanctioned by Apple as not violating the 
Macintosh visual copyright. 

How closely did the original GEM Desktop match the Macintosh interface? Just 
study the next few pages and judge for yourself. 

FINDER 

The operating system of the Macintosh was unlike that of any other contemporary 
microcomputer. This totally graphics-oriented environment is managed with icons 
through a graphics input device. Icons are used for representing physical disk drives, 
files, and a file deletion buffer (the Trash icon). By clicking, dragging, and double­
clicking the mouse input device, the user can perform all of the Macintosh system 
management duties. 

One file that supports the Macintosh operating system is Finder. Finder serves 
as the disk and file management segment of this no-name operating system. While much 
of the previous paragraph listed Macintosh features that have similar counterparts in 
GEM, there are several interesting differences between GEM and Finder. For one, 
Finder is slow. Finder is so slow, in fact, that RAM drives, file caching, and memory 
management systems are used to increase the performance of this lethargic operating 
system (Apple has even recognized this speed deficit and attempted several operating 
system upgrades). 

Another area of difference between GEM and Finder is in the management of disk 
drives and disk files. 

Disk Management 

o Turn the Macintosh on. 
o Insert the System Disk into the internal disk drive. 
o Double-click on the System Disk icon. 
o Eject the System Disk. 
o Insert the Mac Write disk. 
o Double-click on the Write disk icon. 

The Macintosh desktop is now filled with two open windows and two floppy disk icons 
(Fig. 8-1). This is sloppy disk management. These windows and icons all came from 
the same physical disk drive, but were actually housed on two different floppy disks. 
This unusual one drive/multiple icon setup can lead to confusion. Just close both win-
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Fig. 8-1. Two open windows on the Macintosh. In this case, the disk icon is used for representing each physical disk 
and not the number of system disk drives. 

dows and single click on the System Disk icon. Now, which disk is currently in the 
disk drive? Furthermore, try and open the System Disk (double-click on the icon). Finder 
certainly is not a very friendly operating system. 

Renaming a File 

D Click on the file's icon. 
D Click the pointer on the name of the icon. A text cursor appears. 
D Type the new name. 
D Click anywhere else in the desktop. The new name is added to the disk's 

directory. 

Several other Finder-related activities also differ from the equivalent action in GEM. 
An important point to remember here is that one operating system can't be judged 
as better than the other based on their relative merits and demerits in these disk and 
file management actions. 

One area, however, where GEM holds a superior edge over Finder is in peripheral 
support. GEM offers a large assortment of graphics cards, printers, plotters, and cameras 
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for receiving its output. Conversely, Finder is limited to Apple products. Although, 
if you happen to own the Apple Computer's LaserWriter, then your Macintosh couldn't 
care less about not having a variety of output devices. 

DESKTOP 

The Macintosh uses the desktop metaphor for describing the visual appearance of its 
operating system. While Finder serves as the disk and file management portion of this 
operating system, several other files form the backbone of the Macintosh operating 
system. Collectively, these operating system files are known as the System Folder. 
Within this System Folder there are commonly six files: System, Finder, ImageWriter, 
Note Pad, Clipboard, and Scrapbook. There is one file, however, that you can't see 
in the System Folder. Desktop is an invisible file that is completely responsible for the 
maintenance of the Macintosh desktop (Fig. 8-2). Why is Desktop invisible? So that 
you won't accidentally remove this vital file from the System Folder. 

Generally speaking, there are three highlights to the Macintosh desktop: the Menu 
Bar, the disk icon, and the Trash icon. The disk and Trash icons have already been 
mentioned. This leaves only the Menu Bar for receiving the final judgment. 

Menu Bar 

This command line runs along the top portion of the desktop. The Menu Bar holds 

r 

" Control Disk fHp Mise 

01: RAMdisk - K free 
Ham. Prtct lckd Invis last Hodifi.d 

9K Clipboard Fil. 0 0 0 Sun, Jun 22, 1 986 

4K Df'skTop ~O 0 • Sun, Jun 22, 1986 

46K Find.r 0 0 0 Sun, Jun 22, 1 986 

27K Imagf'writf'r 0 0 0 Sun, Jun 22, 1 986 

9K Scrapbook Fil. 0 0 0 Sun, Jun 22, 1986 

Systf'm 0 0 0 Sun, Jun 22, 1986 

57K HacTools" 4.2 0 0 0 Thu, Aug 1 5, 1 985 

Fig. 8-2. A disk utility found in the program Copy II Mac shows that the file Desktop is indeed invisible from the user. 
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five menus: the Apple menu, the File menu, the View menu, and the Special menu. 
Each of these menus must be physically pulled down by placing the pointer over the 
menu name and clicking the mouse button. To continually display a menu for com­
mand selection, the mouse button must be held down until the command has been cor­
rectly highlighted. Then, once the command has been identified, the mouse button is 
released and the command is executed. 

Apple Menu. This menu holds the desk accessories and information dialogs. These 
accessories can be selectively removed for increasing disk storage space. 

About the Finder ... 
Scrapbook 
Alarm Clock 
Note Pad 
Calculator 
Key Caps 
Control Panel 
Puzzle 

File Menu. This is the disk and file management menu. 

Open 
Duplicate 
Get Info 
Put Back 
Close 
Close All 
Print 
Eject 

Edit Menu. The commands on this menu are used for editing text. 

Undo 
Cut 
Copy 
Paste 
Clear 
Select All 
Show Clipboard 

View Menu. These commands structure the icon directory arrangement for all 
windows. 

By Icon 
By Name 
By Date 
By Size 
By Kind 
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Special Menu. This menu holds the commands for controlling the appearance 
of the desktop. 

Clean Up 
Empty Trash 
Erase Disk 
Set Startup 

From this brief introduction to the Macintosh, what is your final verdict on the 
validity of Apple's claimed visual copyright infringement? Does GEM follow the Macin­
tosh desktop and interface to a plagiaristic degree? How about the new version of GEM? 
Does it offer a completely unique graphics environment perspective? Of course, with 
the release of GEM version 2.1, this point is moot. The plaintiff in this case, Apple, 
has accepted GEM 2.1 as being within acceptable boundaries for avoiding copyright 
infringement. Once again, be your own judge. Compare GEM 2.1 from Appendix A 
with the information presented in this chapter. Who knows, you might just get an un­
expected lesson in corporate law. 
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Chapter 9 

Paste 
Performing several functions, simultaneously-this is an adequate definition of mul­
titasking. In reality, true multitasking on a microcomputer can't be accomplished. Be­
cause a microcomputer uses a single MPU, the time allotted for different functions 
must be shared. Therefore, a better definition of multitasking in the microcomputer 
environment would be "performing several functions so that they appear to be executed 
simultaneously.' , 

A truer representative of multitasking with microcomputers is known as concur­
rency. With concurrency, programs are made to run in the background. This background 
operation is similar to the print queuing function of GEM's Print Spooler desk ac­
cessory (or for that matter, DOS's PRINT command). In this case, the listed documents 
are printed in the background, while the GEM application continues to run. Expand­
ing this principle to other computer applications, a concurrent operating system ena­
bles several programs to operate from the same MPU. For example, you could have 
Lotus 1-2-3 recalculate a spreadsheet and WordStar reformat a manuscript, while you 
search a dBase III database. All three of these operations would be happening concur­
rently. 

There are three popular operating systems that open an entirely new window on 
concurrent operation. DESQview, Windows, and TopView are DOS alternatives that 
support concurrent program execution. Furthermore, the use of icons, drop-down me­
nus, and windows makes these three operating systems potential competition for GEM. 

Much to the chagrin of DESQview, Windows, and TopView, GEM can be made 
to function as a concurrent operating system. The procedure is simple and the results 
are far more comprehensive than those that are available from these other three con-
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current systems. By using Concurrent PC-DOS 4.1 (available from DRI) as a separate 
application, a concurrent graphics-based operating system can be created. There are 
two points to remember when making GEM concurrent, however. First, this applica­
tion must be executed from the GEM Desktop. Second, and more important, the con­
current GEM can only be used on a hard drive system. If you obey these two minor 
rules, then you can tum GEM into a concurrent operating system that is capable of 
running up to four applications simultaneously. 

DESQVIEW 

DESQview is a character-based concurrent operating system (Fig. 9-1). Three special 
DESQview features are remarkably powerful: Learn, load files, and virtual memory. 
The remainder of DESQview leaves a lot to be desired. 

Learn 

If you need to type lengthy key sequences to perform a given task, then DESQ­
view's Learn ability will save your fingers. With Learn, each key sequence, or macro, 

A _____________________________________________________ _ ] 

DESQview Help ] 
Version 1.02 ] 

A HOW TO USE HELP: Use the Tab key or the mouse to 
A position the cursor on a highlighted word. Press 
A the Gray + key or crick the mouse to display help. 

] 

] 

] 

] 

] 

] 

] 

] 

] 

] 

] 

] 

] 

] 

] 

]" 

A 

.-\ 

.-\ 

DESQview COMMANDS 

Open Window Switch Window Close Window 

Rearrange Zoom Mark 

Transfer Auto Dialer Quit DESQview 

DESQview PROGRAMS 

DOS Services Lea-I"n t"~larrn Clock 
J 

Add a Program Delete a Program Change a Program ] 
] 

]" 

A Press ? to end help. Press for help index. ]" 
A \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \] 

Fig. 9-1. The DESQview Help Screen. 
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is stored by DESQview in a buffer for subsequent recall. Later when you need to type 
in that sequence, just press a key and DESQview enters the information for you. 

Load Files 

A series of special load files enables DESQview to run several popular programs 
concurrently in its windowed environment. Now, these load files shouldn't be thought 
of as pedestrian device drivers that just shoehorn an application like Lotus 1-2-3 into 
a window. Quarterdeck Office Systems (the maker of DESQview) has cleverly written 
each load file for the named program, which gives a program like Lotus 1-2-3 true con­
currency and windowing ability. For example, these Lotus windows run faithfully in 
the background, in any sized, colored, or positioned window. 

Virtual Memory 

This feature is nothing more than a fancy name for disk/file swapping. In other 
words, if an application is no longer in concurrent use, DESQview will "swap" it to 
the indicated storage medium (floppy, hard, or RAM). There are problems with this 
memory management technique (swapping active applications because of memory limi­
tations) that can lead to a reduction in productivity. 

WINDOWS 

Windows is Microsoft's entry into the graphics-based operating system market. This 
much ballyhooed environment was originally scheduled for a mid-1985 release. Pro­
gramming delays, however, pushed the official market arrival back until the first of 
1986. Once Windows was on store shelves, it was quickly adopted as the leading com­
petitor for GEM. 

Windows approach to the graphics environment combines the power of a bit-mapped 
screen with the unpleasantness of DOS. This bizarre juxtapositioning seriously limits 
Windows replacement of conventional DOS or even Concurrent PC-DOS (if you need 
concurrency). For example, MS-DOS Executive is the original "desktop" that fills the 
PC screen. This application serves as the directory of the Windows Desktop Applica­
tions disk. The MS-DOS Executive sports the standard GEM-like features, including 
a Menu Bar, disk drive icons, and directory path names. Additionally, the MS-DOS 
Executive lists all of the Windows applications in a typically DOS-like manner (Fig. 9-2). 

A typical session with Windows shares many of the same mouse actions that are 
found in GEM. 

o Start Windows. (The Windows Startup disk goes in drive A: and the Windows 
System disk goes in drive B:.) (Hard drive users will have to change the direc­
tory with the CD command, first.) 

o Insert a Windows application disk in drive A:. (e.g., Windows Desktop Appli-
cations disk.) 

o Click the mouse button. 
o Double-click on the Cardfile application. (CARDFILE.EXE) 
o Cavort around the Cardfile index. 
o Open the MS-DOS Executive application. (Drag the disk icon to the right border.) 
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, MS-DOS Executi ve ~ , .' '. _ • 
File Uiew Special 

A6 IIJm 'I B:\HN SYSTB1 \ 
OOlUmll,U. 
COURC.FON 
COURD.FON 
EPSON.DRU f\ 
HELUA. FON ~~ 
HELUC. FON 
HELUD.FON 
MSDOS.EXE 
SPOOLER.EXE 
TMSRA.FON 
Tt,1SRC. FON 
TMSRD.FON 
WIN.INI 
WIN100.0UL 
WINOLDAP.GRB 
WINOLDAP.MOD 

Fig. 9-2. The opening Windows MS-DOS Executive screen. Even IBM systems with PC-DOS will use the MS-DOS Execu­
tive window. 

o See what time it is. 
o Press and hold the Shift key. 
o Double-click on CLOCK.EXE. 
o Drag the Clock icon into active window border area. 
o Size the Clock window. 
o Display the System Menu and choose the Size command. 
o Drag the size pointer to the needed size. 
o Shrink the Cardfile. Drag the Cardfile's Title Bar into the lower icon area. 
o Stop Windows. Display the Special Menu on the MS-DOS Executive's Menu 

Bar. 
o Choose the End Session command. 

Windows Menus 

Just like in GEM, Windows applications have a unique Menu Bar. The basis for 
all desktop operations, however, stems from the System Menu and the MS-DOS Ex­
ecutive Menu Bar. 
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About,., 

System Menu. This menu, which is represented by an icon located in the upper 
left corner of each application window, remains constant throughout all Windows ap­
plications (Fig. 9-3). 

Size-the Size command. 
Move-the Move command. 
Icon-shrinks the active window into an icon. 
Zoom-enlarges a window to full screen size. 
Close-the Close command. 
About •.. -displays information about the application. 

MS-DOS Executive Menus. The commands on these menus operate as disk 
and file managers. 

File Menu: 

Run-the Run command. 
Load-the Load command. 

.~ . 
File View S ecial 
~!!J BI---I A:APPS \ 
ABC. TXT 
CALC.EXE 
CALENDAR.EXE 
CARDFILE.EXE 
CLI PBRD. EXE 
CLOCK.EXE 
CONTROL.EXE 
DOTHIS.TXT 
NOTEPAD. EXE 
PAINT. EXE 
REVERSI. EXE 
TERMINAL. EXE 

Fig. 9-3. The System Menu is displayed on the Calculator window. 
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Copy-the Copy command. 
Get Info ... -displays information about the selected file. 
Delete-the Delete command. 
Print-the Print command. 
Rename-renames the selected file. 

View Menu: 

Short-displays the directory horizontally. 
Long-displays the directory vertically. 
All-displays all of the files in the directory. 
Partial-displays a specified file list in the directory. 
Programs-displays only program files in the directory. 
By Name-sorts the directory alphabetically. 
By Date-sorts the directory by creation dates. 
By Size-sorts the directory by byte size. 
By Kind-sorts the directory by file types. 

Special Menu: 

End Session-quits Windows 
Create Directory-makes a new directory. 
Change Directory-the Change Directory command. 
Format Data Disk-the Format Data Disk command. 
Make System Disk-the Make System Disk command. 
Set Volume Name-gives a disk a name. 

Tying down the graphics environment with excessive DOS-like commands pollutes 
the virtue of Windows. Maybe this is Microsoft's method for avoiding any legal tan­
gles with Apple over visual copyright infringement. Regardless of the reasoning be­
hind this odd combination, Windows loses much of its concurrent benefits by 
hamstringing its user interface. 

POSTMORTEM 
This last concurrent operating system doesn't present any competitive threat to GEM, 
DESQview, or Windows. IBM's Top View is a character-based environment that suffers 
from several performance flaws that seriously undermine either its recommendation 
or its endorsement. Two features stand out as prime examples of IBM Top View's fail­
ings. First, Top View tries its best to be a graphics environment as well as a text han­
dler. This dual desire leads to enormous problems. For example, TopView's Calculator 
is a marvelous credit to character programming, but it is of little practical value in its 
current environment. IBM should heed DESQview's lead and stick to a true character­
based operating system. The second major tick against Top View comes from IBM's 
insistence on paralleling DOS. This duplication is so complete, in fact, that several DOS 
commands appear verbatim in the TopView menus (e.g., DOS's TYPE = TopView's 
Type). What's the benefit of this "alternate" operating system? To IBM's credit, they 
have scheduled upgrades to Top View. Unfortunately, these "improvements" do very 
little to resuscitate the comatose Top View. 
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Appendix A 

GEM Version 2.1 Summary 

In the fall of 1986, DRI released a revised version of the GEM Desktop. The impetus 
for creating this physically remodeled GEM was a pending lawsuit initiated by Apple 
Computer (see Chapter 8). Dubbed GEM Version 2.1, this new desktop shared many 
of the same operations and functions found in the former GEM Version 1.0. Improve­
ments to the GEM design, however, can be noted in several key areas: 

1. The presence of optional keystrokes for specific menu commands. 
2. Improved OUTPUT layout and function. 
3. The addition of a new font set-Dutch. 
4. Each drive has a window. 
5. Each window is always active. 
6. Pressing the Escape key (Esc) updates all active windows. 
7. All Version l.X GEM applications (GEM Collection, GEM Draw, GEM Graph, and 

GEM Word Chart) can be installed on the GEM 2.1 Desktop. 

Along with these enhancements, there are several disappointments in GEM Ver­
sion 2.1: 

1. There is no Size Box on the disk drive windows. (Curiously enough, there is a Size 
Box on the OUTPUT window.) 

2. Disk drive windows can't be dragged to a new location on the GEM 2.1 Desktop. 
3. The trash icon has been removed. 
4. Menus on the Menu Bar are no longer grouped from left to right. 
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Before the GEM 2.1 Desktop can be used, it must be installed through the GEM­
PREP command. The procedure is identical to the GEM Version 1.0 GEMPREP in­
stallation, which is discussed in Chapter 1. 

o Place your copy of the GEM SYSTEM MASTER disk in disk drive A:. (Yes, 
GEM Version 2.1 is not copy protected.) 

o Type: GEM PREP 
o Press the ENTER key. 

You will be greeted by: 

We1come to GEMPREP! This procedure will install the GEM Desktop on your 
computer. 

Do you want to put the GEM Desktop on a hard disk? YIN? 

Answer this question and proceed through the remainder to the installation. 
Note: Dual-floppy-disk-drive systems will follow a slightly different installation path 

from that used by hard drive systems. 

o Respond with "N" to the above question. 

The following question appears: 

Does your system have two floppy disk drives? YIN? 

o Type Y 
o Prepare a GEM DESKTOP disk and a GEM STARTUP disk. 

In both installation cases, you will be required to know the following hardware ~pecifics: 

1. Type of graphics display card. 
2. Type of graphic input device (e.g., mouse). 
3. The port that connects the graphic input device to your system (e.g., COMl). 
4. The type of output device. (e.g., Apple LaserWriter). 
5. The port that connects the output device to your system (e.g., COM2) 

Once all of these questions have been answered, the completed GEM 2.1 Desktop 
is configured and copied onto either the hard disk or the twin floppy disks. Table A-I 
lists all of the subdirectories and files that constitute the GEM 2.1 Desktop. 

Like its GEM 1.0 Desktop ancestor, the GEM 2.1 Desktop must be rebooted fol­
lowing the GEMPREP installation (floppy disk users, remember to place the GEM 
STARTUP disk in drive A: prior to using the Ctrl + Alt + Del rebooting keystroke se­
quence). After the computer has been restarted: 

o Type: GEM 
o Press the ENTER key. 
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STARTUP 

COMMAND.COM 
MODE.COM 

DESKTOP 

EMAPPS < DIR > 
GEMDESK <DIR> 

GEMBOOT <DIR> DESKTOP .APP 
DESKTOP.RSC 
DESKTOP.lNF 
DESKTOP.ICN 
DESKHI.ICN 
DESKLO.ICN 

GEM.EXE 
GEM.RSC 
CALCLOCK.ACC 

GEMSYS < DIR > Table A-1. GEMPREP 2.1 Copies These 
Directories, Subdirectories, and Flies onto 

Either a Hard Disk or Two Separate Floppy Disks. 
GEMVDI.EXE 
ASSIGN.SYS 
IBMCHMPS.SYS 

GEMSYS < DIR > 
FORMAT.COM 
*.FNT GEM.BAT 
*.SYS 
METAFILS.SYS 
OUTPUT.APP 
OUTPUT.RSC 

GEMSCRAP < DIR > 
COMMAND.COM 

Make sure that you are in the root directory before you enter this command (us~ the 
change directory DOS command, if necessary). 

Figure A -1 fills your display as your initial welcome to the GEM 2.1 Desktop. Con­
trol of the new GEM Desktop, menu contents, and dramatic changes to specific con­
trol dialogs are illustrated in Figures A-2 through A-S. 

Another area of the GEM Desktop that received drastic alteration was OUTPUT. 
Selecting the To Output command from the File Menu of the GEM Desktop places 
the OUTPUT application on the screen (Fig. A-9). Although the operation of OUT­
PUT 2.1 remains identical to its Version 1.0 cousin, there are major differences in the 
execution of OUTPUT 2.1. The most obvious changes are in: 

1. Removal of the Edit Menu (Fig. A-10). 
2. Numbered item entries (there are a total of 36 entry spaces). 
3. Output device icons. 
4. A new menu-Preferences (Fig. A-11). 
5. Two new commands on the Preferences Menu: 

Global ... This command controls the preferences for all output devices, regard­
less of their type. For example, the number of output copies is set with this command 
(Fig. A-12). 

Shortcuts ... A two-page dialog listing several keystroke and mouse button short­
cuts that can be used with OUTPUT (Fig. A-13). 

The final area of the GEM 2.1 Desktop to receive a revamping was GEM SETUP . 
Unlike the Desktop and OUTPUT, GEM SETUP sports only a superficial physical 
"touchup." Other than a Menu Bar rearrangement, the repositioning of one command, 
the addition of several extra peripheral choices, and the inclusion of the "new" GEM 
look (no active windows, modified Sliders, and new direction arrows), GEM SETUP 
2.1 is the same as GEMSETUP 1.0 (Fig. A-14 and Fig. A-15). 

The bottom line with any revision as major as that found in the GEM 2.1 Desktop 
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File Options Arrange DESKTOP 

Fig. A-1. The GEM 2.1 Desktop. 

~ 
FLOPPY 0 ISK FLOPPY 0 ISK 

DDDDDDD 
N~w F old~r GEMSOOT GEMSVS AUTOE:~EC .eAT GEMJAT COMMAND. COM QWH ICs.cOM 

DD 
Fig. A-2. Either disk drive can be assigned to either window. The Close Box is used for moving back­
wards through a disk's subdirectories. 
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To ut GEHDESK GEI-1$CW GEI-1S'v'S CQllH~ND. COI'1 

Exi DOS 

Fig. A-3. The GEM 2.1 Desktop File Menu. Notice the keystroke options for certain commands. 

DO 
GEHSYS COHH~NO. COH 

Fig. A-4. The GEM 2.1 Desktop Options Menu. 
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• New Fold 
• GEMAPPS 
• GEMDESK 
• GEMSCRAP 
• GEMSYS 

COMMAND COM 

• New Folder 
DRAW APP 
DRAW RSC 

12:88 aM 
09:29 aM 
89:29 aM 

87-15-86 89:29 aM 
87-15-86 89:29 aM 

23791 12-38-85 12:88 PM 

00-80-80 12:88 aM 
78336 04-89-85 82:17 aM 
10259 04-09-85 82:18 aM 

Fig. A-S. The GEM 2.1 Desktop Arrange Menu. The Show as text command has been previously 
selected. 

.... ,'.y 

Add HaMe", 

hd ~!l;~! N(l!~~! 

~':'~1:.:. ;;~~:'\l:'\\ ~ :~::.:t .: -:' . ,... .,,',11 • /;,t \", ' :: '-::, .. ~ $ ~ :' .. ~ :'" .... : . .: :: ' ~, 

Fig. A-6. All of the standard 2.1 Desk Accessories are on the Desktop. 
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SET PREFERENCES 

ConfirM deletes? ~ CJBQ:] 
ConfirM copies? ~ CJBQ:] 

Double-click speed: []IQ[J II rn rn ClliD 
Sound effects: IImII ~ 

T be forMat: ,"'Wi, I 24 Hour I 
Date forMat: Itlt,.,.,III, I Do-AA-YY I ~ 

I OK I I cancel! 

Fig. A-7. Two format parameters are now controllable with the Set Preferences ... command on 
the Options Menu. 

Application naMe: ~OMlljA_ND I C_OH 
DocuMent types: !-

Application type: ~ ~ 

Needs full MeMory? ~ ~ 

Icon type: 

DOS-takes paraMeters 

Fig. A-S. Very little has changed with the Configure application •.• command. 
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File Preferences OUTPUT 

Fig. A-g. The OUTPUT 2.1 screen. 

Fig. A-10. The OUTPUT File Menu. 

192 



Fig. A-11. The OUTPUT Preferences Menu. 

File OUTPUT 

GLOBAL PREFERENCES 

NUMber of copies: 1~ 
Horizontal position: [eh ImD I Ri hfl 

Vertical position: To~ IIm~!1I I BottOM I 
Auto display? Yes .~I'II ~ 

~R I ~anceI I 

Fig. A-12. The Global .•. command is a new addition to OUTPUT 2.1. 
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File 

MOUSE BUTTON SHORTCUTS 

Double-click on a device icon to 
display and set its preferences. 

ITEH SElECTOR SHORTCUT 

To add All naMes specified in the 
Directory line to your output list, 
leave the "Selection" line eMpty and 
click on OK or press Enter. 

Fig. A-13. Selecting the Shortcuts .•• command displays a two-page dialog. 

OUTPUT 

GEMSETUP 

aQ or 0 er e Wl S 
I" Enhanced Card I MonochroMe Dis~la~ (6 -----

Enhanced Card I Color Display (640x200) 8 c rs 
:,:':': Enhanced Card I Color Display (640x200) 16 color-----
,',' IBl,j Enhanced Card & Display (640x3S0) 8 colors 
:':,', IBM Enhanced Card & Display (640x350) 16' color-s -----­

IBM 3270 PC (720x3S0) 2 colors 
Hercules Card I ~fonochroMe PC W"'I'Ol-sp""la-y-'('IIII'JI72~Ox"'lt"'341nr'8T"'"') ------
AT&T MonochroMe Card (640x400) 

::: AT&T DEB Card (640x400) 16 col-or-s ---------
.:. " 

Fig. A-14. The GEMSETUP File Menu. 
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CEMSETUP 
,'I,; ,!\l: '" 

Chosen Screen Fonts 
olnt point-------------

Point ____________ _ 
Point ____________ _ 

Available Screen Fonts 
olnt Point-------------

Point ____________ _ 
Point ____________ _ 
Point ____________ _ 

~ ____ ii-irr~""'T-,_,r_'Point--------_-----

Fig. A-15. The GEMSETUP Categories Menu. 

, 

is, "should I upgrade?" O'f course, the definitive answer in this situation is "maybe." 
Before you write off this response as being unduly flip, let's weigh the pros and cons 
of upgrading from the GEM 1.0 Desktop to the GEM 2.1 Desktop. First, the pros: 

1. Approved desktop configuration. 
2. Improved user interface through optional command keystrokes. 
3. Enhanced output device control. 
4. Addition of a new system font. 
5. Future GEM applications will be compatible. 

Now, the cons: 

1. Unnecessary expense. 
2. Reduced flexibility in Desktop management. 
3. New Dutch font is available through GEM Word Chart 1.0. 
4. Restricted to GEM 1.0 applications. 

In short, upgrade to the GEM 2.1 Desktop, if you wish to remain compatible with 
future version releases of GEM applications. On the other hand, if you are satisfied 
with the current crop of GEM applications, keep the GEM 1.0 Desktop. Either way, 
it sure beats plain DOS. 
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Appendix B 

GEM/DOS Equivalents 

The following list provides a reasonable comparison between GEM Desktop commands 
and their PC-DOS representatives. 

GEM Desktop Command 

Calculator 
Clock 
Close 
Close Window 
Drag icon 
Desktop Info 
Enter DOS Commands 
Format 
Install Disk Drive 
Install Application 
ITEM INFORMATION dialog 
New Folder 
Open 
Print Spooler 
Quit 
Save Desktop 
Set Preferences 
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PC-DOS Command 

TIME & DATE 
Ctrl + Alt + Del 
CLS 
COPY 
VER 
Default state 
FORMAT 
CONFIG.SYS w/LASTDRIVE = 

FDISK 
RENAME 
MKDIR 
DIR 
PRINT 
Ctrl + Alt + Del 
AUTOEXEC.BAT 
MODE 



GEM Desktop Command 

Show as Icons 
Show as Text 
Show Info 
Snapshot 
Sort by Date 
Sort by Name 
Sort by Size 
Sort by Type 
To Output 
Trash 

PC-DOS Command 

DIR 
CHKDSK 
GRAPHICS 

SORT (text files only) 

MODE + PRINT 
ERASE 
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Appendix C 

GEM Icon Summary 

Six standard icons are used through the GEM Desktop. These icons represent physi­
cal system contributions. Each icon, with its conventional written label, is illustrated 
in Fig. C-l. 
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Document 

Fig. C-1. 

A 

~ 
I 

Floppy Disk 

Application Folder 

c 

• WhYNNM'hWN.'I,Wh\\Wh 

Hard Disk Trasn 
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Appendix D 

The GSX Standard 
A precursor to the GEM VDI was the Graphics System Extension or GSX developed 
by DRI (refer to Chapter 7 for a complete discussion of the GEM VDI). The GSX pro­
gram, like its VDI counterpart, added a device-independent graphics ability to an oper­
ating system. Therefore, applications written under the tutelage of the GSX standard 
would be highly portable programs with a ready implementation possible on any com­
puter that is able to address the parental operating system. 

A good example of the GSX is found in DRI's CP/M-86 operating system. GSX-86, 
as this GSX version is known, provides three general functions in the CP/M-86 environ­
ment (this can be either the "normal" CP/M-86 operating system or the multifunction 
Concurrent CPIM-86 operating system): coordinate translation, fielding graphic requests, 
and supporting device drivers. 

The usual downfall for any graphics program centers around the handling of the 
aspect ratio. Generally speaking, the aspect ratio is what makes a circle look like a cir­
cle instead of appearing to be an oval. An example of a bad aspect ratio is seen when 
you draw a circle on the monitor and it prints as an oval on your output device. GSX-86 
delivers a perfect aspect ratio by dealing in a separate set of two-dimensional, carte­
sian coordinates for both the monitor and the output device. A special translation for­
mula provides the conversion between the monitor coordinate system and the version 
used by the output device. Therefore, any graphics image designed on the monitor shares 
the exact same proportions on the output device. 

All graphics requests sent from the application to the output device are intercepted 
by GSX-86. This sidetrack allows GSX-86 to customize the graphics messages for un-
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derstanding all of the special requirements exhibited by the selected output device. 
An attractive fringe benefit from this request fielding is that any application running 
under a GSX-86 supported operating system can remain detached from all matters that 
pertain to driving the connected peripherals. 

The actual information that is used by GSX-86 for dealing with these peripherals 
is contained within unique, specialized utility programs known as device drivers. Each 
device driver used by GSX-86 is written specifically for the device that will be receiv­
ing the output. But GSX-86 is not limited to a single device driver. Even if you plan 
on using several different peripherals, GSX-86 can address all of the device drivers 
that are needed for supporting these mUltiple output devices. An ASSIGN .SYS file 
holds the device driver names that will be loaded by GSX-86. By modifying this file, 
extra drivers can be added as new peripherals are connected to your system. 

Once GSX-86 has been installed and the device drivers have been read from the 
ASSIGN.SYS file, the application is able to deal with any connected peripheral and 
monitor combination. Of course, this action is familiar to every GEM user. Manyelabo­
rations have been added to the GEM VDI from this humble beginning at device inde­
pendence. Probably the greatest attraction of this universal driver interface, however, 
is that the function of GSX-86 is invisible to the user. Thoughtfully, DRI retained this 
feature when they developed the GEM VDI. 
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Appendix E 

Using DOS-based Software 

in the GEM Environment 
Not only is the GEM Desktop able to utilize GEM-based applications, it is also able 
to manipulate numerous standard DOS-based applications as well. Before any of these 
DOS products can be used by GEM, however, they must be installed on the GEM Desk­
top. Any software product can be installed in this manner, including programs on both 
floppy and hard drives. 

To Install a DOS-based application: 

o Start GEM 
o Select the blank icon that represents the DOS software for installation. 
o Display the Options Menu. 
o Choose the Install Application ... command. The INSTALL APPLICA-

TION dialog appears. 
o Fill in the fields on the dialog. 
o Click on the "install" button. 
o Display the Options Menu. 
o Choose the Save Desktop command. 

These last two steps are vital for making GEM "memorize" this installed DOS 
program. In the future, whenever you start the GEM Desktop, this installed program 
will be both recognized by GEM and executable from the GEM Desktop. 

The following completed INSTALL APPLICATION dialogs (Fig. E-l through Fig. 
E-5) will guide you during the installation of several popular DOS programs: 
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Fig. E-1. 

Fig. E-2 

I [\JSTALL APPLICATION 

Application Nanle: ACAD.EXE 
Do(:unlent Types: CI'NG ______ _ 

Application Type: I GENll Em ID()S -takes parametersl 
r'Jeeds Full rVlenl,jry: I YES I 1m 
Icon Type: Dravv 

t 

+ 

I Remove I I Cancel I 

I [\JST ALL APPLI CATI (>N 

.Application [\Janle: ~·~TALK. C()~ll 
Docunlent Types: ~·:T"r:: ______ _ 

Application Type: I GErVll1D ID<)S -takes pararnetersl 
Needs full rVlenlQry: \YEsl a 
Icon Type: 

+ 

II nstalll I Renlove I I Cancel I 
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Fig. E-3. 

Fig. E-4. 
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INSTALL APPLICATIC)N 

Application Nan1€.-: C:C)~,~~,~A(\JD. CO~ll 
Docunlent Types: _______ _ 

Application Type: I GErVll1 DC)S I 
Needs FuJI rvlenl0ry: iYESI IB 
Icon Type: I:::::::::::: r-. rl-II' .. a ..... n1 ~ .. ,.... TO ,-.1 :::::::::::::::::1 '"'''',,''' r- "':-t I 1111 "= I ,:j I .q ,,,,,,,,,,,,,,,,,' 

:::::::::::: .. ::::::::::::::::: 

+ 

II nstall , I Remove I 

I [\JSTALL APPLICATION 

Application Nan1€.-: 123. E;-:E 
DI)(:unlent Types: \~l'r::~, 'NK1 _____ _ 

Application Type: IGEN1! 1m IDOS -takes paranletersl 
Needs Full rVlenl0ry: iii I NO I 

Icon Type: I:::::::::::: ,... - j n -_ .. 
"""""" .--rlr ... al S ...... 1 
111111111111 '..I t- - - - • 

:::::::::::::::::::1 

t 

t 

I' nstalll i Renl0ve I I Cancel I 



I [\JSTALL APPLICATION 

Application (\Janle : TURBO. C()~II 
[)o(:unlent Types: F',l.5 ______ _ 

Application Type: I GEM I_I DOS -takes parameters I 
r\Jeel:1s Full rVlen1(lry: IVESI • 
Icon Type: :::::::::::: Programmer's Tool ::::::::::::::::: ....... u... .. ............... 

1111 ...... 11 .It. 1111' 1111 1111 ............ .. ............... 

[iJ @ 
t 

I ••••••• 

"""" 

........ ........ .. , ..... 
~pplic~,tiorl docurlicnt~ , •• ,1, •• 

I ••••••• 

t 

I Install I I Remove I I Cancel I 
Fig. E-S. 
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Glossary 

address-The location in memory where a given binary bit or word of information 
is stored. 

alphanumeric-The set of alphabetic, numeric, and punctuation characters used for 
computer input. 

analog/digital (A/D) conversion-A device that measures incoming voltages and 
outputs a corresponding digital number for each voltage. 

ASCII-American Standard Code for Information Interchange. 
assembly language-A low level symbolic programming language that comes close 

to programming a computer in its internal machine language. 

binary-The base two number system, in which 1 and 0 represent the on and off states 
of a circuit. 

bit-One binary digit. 
boot-To start a computer. 
bottom layer-The element or elements that are drawn first in GEM Draw. Con-

trast this definition with top layer. 
byte-A group of eight bits. 

chip-An integrated circuit. 
click-One press of the mouse button. 
concurrent operation-Executing two or more RAM-based applications through 

shared CPU time. 
CP/M-Control Program for Microprocessors; an 8-bit microcomputer operating sys-
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tem developed by DR!. 
CPU-Central Processing Unit; the major operations center of the computer where 

decisions and calculations are made. 
CPU time-The execution time used by the CPU, exclusive of I/O functions. 
CMOS-A Complementary Metal Oxide Semiconductor IC that contains both P-channel 

and N-channel MOS transistors. 

data-Information that the computer operates on. 
data rate-The amount of data transmitted through a communications line per unit 

of time. 
debug-To remove program errors, or "bugs," from a program. 
digital-A circuit that has only two states, on and off, which are usually represented 

by the binary number system. 
disk-The magnetic media on which computer programs and data are stored. 
double-click-Two rapid clicks of the mouse button. The length of the pause be­

tween clicks can be set by the user through the Set Preferences ••. command. 
DOS-Disk Operating System; allows the use of general commands to manipulate the 

data stored on a disk. 
drag-Click on an icon and continue holding the mouse button down, while moving 

the mouse. 
driver-A utility application containing the necessary information for supporting the 

specified peripheral. 

EPROM-An Erasable Programmable Read-Only Memory semiconductor that can 
be user programmed. 

firmware-Software instructions permanently stored within a computer using a read 
only memory (ROM) device. 

floppy disk-See disk. 
flowchart-A diagram of the various steps to be taken by a computer in running a 

program. 

hardware-The computer and its associated peripherals, as opposed to the software 
programs that the computer runs. 

hard disk-A non-removable storage medium with a fast access time. IBM refers 
to this media as fixed disks. 

hexadecimal-A base sixteen number system often used in programming in assem­
bly language. 

icon-A pictorial representation of a definable object. 
input-To send data into a computer. 
input/output (110) devices-Peripheral hardware devices that exchange informa­

tion with a computer. 
interface-A device that converts electronic signals to enable communications be­

tween two devices; also called a port. 
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languages-The set of words and commands that is understood by the computer and 
used in writing a program. 

loop-A programming technique that allows a portion of a program to be repeated 
several times. 

LSI-Large Scale Integration; a layered semiconductor fabricated from approximately 
10,000 discrete devices. 

machine language-The internal, low level language of the computer. 
memory-An area within a computer reserved for storing data and programs on which 

the computer operates. 
microcomputer-A small computer, such as the Commodore Amiga, that contains 

all of the instructions it needs to operate on a few internal integrated circuits. 
mnemonic-An abbreviation or word that represents another word or phrase. 
mouse-A small desk-top rolling device that sends electronic codes to the computer, 

causing cursor movement. 
moving-Moving the mouse on the physical desktop produces a representative move-

ment on the GEM Desktop. 
MOS-A Metal Oxide Semiconductor containing field-effect MOS transistors. 
MPU-MicroProcessor Unit; the central processing IC or chip. 
multitasking-Executing two or more applications or tasks at the same time. 

NMOS-An N-channel Metal Oxide Semiconductor with N-type source and drain diffu­
sions in a P substrate. 

octal-A base eight number system often used in machine language programming. 
opcode-An operation code signifying a particular task to be performed by the 

computer. 

parallel port-A data communications channel that sends data out along several wires, 
so that entire bytes can be transmitted simultaneously, rather than by one single 
bit at a time. 

peripheral-An external device that communicates with a computer, such as a printer, 
a modem, or a disk drive. 

PMOS-A P-channel Metal Oxide Semiconductor with P-type source and drain diffu­
sions in an N substrate. 

point-A reference "mark" produced by moving the GEM Desktop pointer via a mouse 
movement. 

program-A set of instructions for the computer to perform. 
RAM-Random Access Memory; integrated circuits within the computer where data 

and programs can be stored and recalled. Data stored within RAM is lost when the 
computer's power is turned off. 

ROM-Read-Only Memory; integrated circuits that permanently store data or pro­
grams. The information contained on a ROM chip cannot be changed and is not lost 
when the computer's power is turned off. 

RS-232C-A standard form for serial computer interfaces. 
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select-Clicking the pointer on an icon. 
serial communications-A method of data communication in which bits of infor­

mation are sent consecutively through one wire. 
soft crash-A system loss that can be recovered through rebooting the software disk. 

Data will still be lost through this crash, however. 
software-A set of programmed instructions that the computer must execute. 
statement-A single computer instruction. 
subroutine-A small program routine contained within a larger program. 

terminal-An input/output device that uses a keyboard and a video display. 
top layer-The element or elements that are drawn last in GEM Draw. Contrast this 

definition with bottom layer. 

tree-A hierarchical file or object structuring with the root or base element situated 
at the top of the network. 

word-A basic unit of computer memory usually expressed in terms of a byte. 
write protect-A technique for preventing a computer's disk drive from writing data 

to the storage medium. 
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6 
68000 instruction set, mnemonic al­

phabetical listing of, 52 

8 
8088 instruction set, mnemonics for, 

51 

A 
absolute mode, 168 
active zone, 153 
alarm mode, 21 
ambiguous file reference, xii 
application environment services 

(AES), 169 
arrows, 17 
aspect ratio, 200 
AUTOEXEC.BAT file, 7, 9 

GEM startup disk containing, 9 

BOOS, xi 
BIOS, xi 

B 

bit-mapped images, 112 

C 
calculator accessory, 19, 20 
cameras 

color option for, 42 
film option for, 41 
fonts for, 48 
ports for, 48 

clicking, 10 
close box, 14 

clicks vs. commands, xxiv 
clock accessory 
color monitors 

EBM enhanced graphics adapter, 
62 

Hercules color card, 61 
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Princeton graphic systems 
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Tandy CM-2 high resolution mon-
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color window, 83 
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CP/M-86 commands listing, xiv 
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disk information, 23 
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directory 
displaying the, 18 
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disk icons, 9 
disk information dialog, 23 
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DOS-based software in GEM en­
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7470A, 747A, 7440, 7550, 64 
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file directory management, xxiv 
file menu, 23 
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folders, xxi 
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compatible computers for, 1 
disk management of, 174 
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ATARI 520ST, 53 
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PCXT, 54, 56, 57, 58 
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Sperry PC, 60 
Tandy 1000 & 1200 HD, 60 
Zenith,59 

GEM Desktop 
additional management com-
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auto-execution batch file for, 6 
batch file for, 6 
creating AUTOEXEC.BAT file for 
starting, 7 

keyboard equivalents for, 48 
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mouse movement with, 10 
OUTPUT command for, 32 
two active floopy and one hard 
disk drive in, 6 
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version 2.1 summary for, 185-195 
windows in, 12 
work area of, 15 
working on, 5 

GEM Draw, 112 
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arrange menu for, 125 
backing up, 113 
color menu for, 127 
creating MY.SYM with, 129 
desk menu for, 120 
drawing surface for, 117 
edit menu for, 122 
element menu for, 117, 127 
file menu for, 121 
font menu for, 123 
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line menu for, 127 
menu bar for, 116 
page menu for, 123 
panner for, 118 
pattern menu for, 127 
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title bar for, 117 
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data window for, 136 
desk menu for, 138 
edit menu for, 140 
file menu for, 138 
font menu for, 144 
gallery menu for, 141 
graph for, 137 
importing data into, 145 
installing, 132, 133 
menu bar for, 135 
options menu for, 142 
placing two graphs on single page 
with, 145 

reference for, 138 
title bar for, 135 
toolkit for, 137 
using, 134 
working in display window with, 
137 

GEM Paint 
advanced techniques for, 86 
backing up, 70 
brush shape command for, 79 
color palette for, 74 
desk menu for, 75 
drawing commands for, 85 
file menu for, 77 
font menu for, 82 
installing, 69, 71 
line palette for, 74 
menu bar for, 73 
microscope tool for, 84 

painting surface for, 74 
pattern palette for, 74 
patterns menu for, 79 
reference for, 74 
selection menu for, 79 
size picture for, 79 
snapshot utility, 76 
style menu for, 82 
title bar for, 73 
tools menu for, 77 
tools palette for, 74, 83 
transparent overlay command for, 
79 

using, 73 
GEM Programmer's Toolkit, 164 

GEM AES, 168 
GEM resource construction set 
(RCS), 171 

GEM VOl with, 166, 200 
porting GEM with, 166 
sample application of with, 165 
sample desk accessory with, 165 

GEM VOl, 200 
GEM Version 2.1, 185-195 
GEM WordChart, 147 

advanced techniques for, 161 
backing up, 148 
bullets, numbers, and letters with, 

161 
color with, 160 
converting .BAK to, 162 
designing borders with, 157 
desk menu for, 154 
edit menu for, 156 
file menu for, 155 
font style and size with, 161 
installing, 148, 150 
installing Dutch font of, 151 
keyboard commands for, 153 
menu bar for, 151 
mouse activities and equivalents 
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options menu for, 159 
pointer for, 153 
references for, 153 
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template menu for, 157 
text alignment with, 161 
text template for, 152 
title bar for, 152 
toolkit for, 153 
toolkit tools for, 160 
using GEM Draw with, 161 

GEM Write 
advanced techniques for, 109 
backing up, 88 
capabilities of, 87 
cursor for, 93 
desk menu for, 97 
double-dot commands for, 
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edit menu for, 101 
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file menu for, 98-101 
font menu for, 104-107 
highlighting text with, 93 
installing, 88, 89 
keystrokes for, 95 
menu bar for, 91 
mouse activities and keyboard 
equivalents for, 96 

options menu for, 107 
reference for, 97 
search menu for, 102 
special features of, 95 
status line for, 93 
using, 91 
Wordstar command structure vs., 
94 

GEMPREP,2 
GEM PREP 2.1, 187 
GEMSETUP,44 
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desk menu for, 45 
device drivers for, 43 
file menu for, 45 
using, 91 

graphics device operating system 
(GDOS), 166 

graphics environment manager 
(GEM), xviii 
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graphics system extension (GSX), 
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hard disk drives, 66 
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DriveCard,67 

Plus Development Hardcard, 67 
Seagate 20M-byte Internal Hard 
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directory, 15 
disk,9 
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input, mouse devices for, 62 
install application, 26, 27 
item (GEM file), xxi 
item information dialog, xxi, 24 
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limited multitasking kernel, 169 
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margin indicators, 152 
master control program (MCP), viii 
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AST SixPak Plus, 66 
IBM 64/256Kb Memory expansion 
option, 66 

Intel Above Board, 66 
Orchid Conquest, 66 
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menu-resident GEM commands, xix 
menus 

desk, 19, 20 
displaying, 17 
GEM Desktop file, 23 
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GEMSETUP desk, 45 
GEMSETUP file, 45 
options, 25 
output desk, 33 
output edit, 37-38 
output file, 34-37, 
output options, 38-43 
view, 18,24 

metafiles,48 
monochrome monitor 

AST preview, 60 
COMPAQ display adapter, 60 
Hercules graphics card, 61 
IBM monochrome display, 60 
Paradise modular graphics card, 
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Princeton graphics systems 
MAX-12,60 

Tandy VM-3 monitor, 60 
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LOGITECH LOGIMOUSE C7, 62 
Microsoft mouse, 62 
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tablets, 63 

SummaMouse, 63 
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special, 12 
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multitasking, 179 

o 
operating system/360 (OS/360), ix 
options menu, 25, 26 
OUTPUT command 
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menu bar for, 33 
overview for using, 32 
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PATH command, 28 
personal computer disk operating 

system (DOS), xiv 
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plotter ports, 48 
point mode, 168 
pointer, 10 

porting, 166 
print spooler, xxiii 

using the, 22 
printer option, 40 
printers, 40 

fonts for, 48 
ports for, 48 

prompt symbol, xii 
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ready acknowledg ment, xii 
renaming, 32 
resource construction set (RCS), 

171 
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screen manager, 169, 170 
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select boxes, 153 
set preferences dialog, 28 
shell, 170 
shift-click, 12 
show info, xxiii 
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soft crash, 3 
source drive, xvii 
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system, viii 
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text cursor, 153 
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GEM vs., 184 
TPA, xi 

T 
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unambiguous file reference, xii 
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